
ปฏิบัติการที่ 12 การวิเคราะห์ทางสถติิแบบนอนพาราเมตริกซ์ 2 

 

 ในปฏิบตัิการนี ้เป็นการฝึกวิเคราะห์ข้อมูลโดยใช้วีธีการวิเคราะห์ทางสถิติแบบนอนพาราเมตริกซ์ได้ ได้แก่ (1) 
Wilcoxon Signed-Rank test (2) Kruskal-Wallis test และ (3) Spearman’s rank order correlation coefficient 

 
1. Wilcoxon Matched-Pairs Signed-Rank (WSR) Test 

 การทดลองที่มีตวัแปรแบบ nominal variable จ านวน 2 ตวัแปร และตวัแปรแบบ scale variable อีก 1 ตวั
แปร ส าหรับตวัแปรแบบ nominal variable นี ้มีตวัแปรตวัหนึ่งมีค่าเป็น 2 ค่า เช่น ก่อนทดลองกบัหลงัทดลอง สว่นตวั
แปรอีกตวัหนึ่งเป็นตวัแปรแสดงตวัตนของค่าข้อมลูดิบแตล่ะค่า อย่างไรก็ตาม การเตรียมข้อมลูส าหรับการวิเคราะห์ด้วย  

SPSS 22 ตวัแปรที่มีค่าเป็น “ก่อนทดลอง” กบั “หลงัทดลอง” จะใช้ตวัแปร 2 ตวัแปรส าหรับเก็บค่าข้อมลูดิบตวัแปรที่เป็น 

scale variable ทัง้นี ้ตวัอย่างข้อมลูจาก Laureysens et al. (2012)1 ซึ่งเปรียบเทียบปริมาณอลมูิเนี่ยมในต้น poplar 
โดยเก็บตวัอย่างไม้ในเดือนสิงหาคมกบัตวัอย่างไม้ในเดือนพฤศจิกายน แล้ววิเคราะห์เปรียบเทียบปริมาณอลมูิเนียม ซึ่ง
ผู้วิจยัต้องการทราบวา่การสะสมอลมูิเนี่ยมในช่วงเวลาทัง้สองเดือนมีความแตกตา่งกนัหรือไม่  

Location 
Aluminum in poplar wood (μg Al per g wood) 

August November 

Balsam Spire 8.1 11.2 

Beaupre 10.0 16.3 

Hazendans 16.5 15.3 

Hoogvorst 13.6 15.6 

Raspalje 9.5 10.5 

Unal 8.3 15.5 

Columbia River 18.3 12.7 

Fritzi Pauley 13.3 11.1 

Trichobel 7.9 19.9 

Gaver 8.1 20.4 

Gibecq 8.9 14.2 

Primo 12.6 12.7 

Wolterson 13.4 36.8 

 จากตวัอย่างข้อมลู ตวัแปรที่เป็น nominal variable ตวัแรกคือ Location ซึ่งเก็บข้อมลูสถานที่เก็บตวัอยา่งไม้ 
สว่นตวัแปรแบบ nominal variable ตวัที่สองคือตวัแปรที่เก็บช่วงเวลาที่เก็บตวัอยา่ง ซึง่ได้แก่ August หรือ November 
(เทียบได้กับ “ก่อนทดลอง” กับ “หลงัทดลอง” ตามล าดบั) ส่วนตวัแปรที่เป็น scale variable คือ ปริมาณอลมูิเนี่ยมใน
ตวัอยา่งไม้ ในตารางตวัอยา่งข้อมลูข้างต้น สถานท่ีเก็บตวัอยา่งไม้แตล่ะที่ จะมีคา่อลมูิเนี่ยมใน August และ November 
เป็นคู่ ๆ หากพิจารณาโดยผิวเผิน จะเห็นได้ว่าตวัแปรที่สองนี ้ดเูสมือนว่าเป็นตวัแปรแบบ scale variable จ านวน 2 ตวั
แปร 
 การเตรียมข้อมูลจะใช้ตวัแปรอย่างน้อย 2 ตวัแปร คือ ตวัแปรที่แรก ช่ือ month1 ประเภทข้อมูล (type) แบบ 

numeric มีค าอธิบาย Al in microgram per gram wood in August และมี measure เป็น scale สว่นตวัแปรที่สอง
ช่ือ month2 ประเภทข้อมูลแบบ numeric มีค าอธิบาย Al in microgram per gram wood in November และมี 

                                                 
1

 Laureysens, I., R. Blust, L. De Temmerman, C. Lemmens and R. Ceulemans. 2004. Clonal variation in heavy 

metal accumulation and biomass production in a poplar coppice culture. I. Seasonal variation in leaf, wood and 

bark concentrations. Environmental Pollution 131: 485-494. 
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measure เป็น scale อย่างไรก็ตาม หากต้องการป้อนค่าข้อมลูดิบของสถานที่เก็บตวัอย่างไม้  อาจเพิ่มตวัแปรอีก 1 ตวั
แปร ช่ือ location ประเภทข้อมลูแบบ string (ความยาว 15 ตวัอกัษร)  มีค าอธิบายเป็น Sites where wood samples 

were collected และมี measure เป็น nominal 

 สมมตุิฐานจะตัง้ดงันี ้
Ho: คา่มธัยฐานของผลตา่งระหวา่งปริมาณอลมูิเนี่ยมในเนือ้ไม้ที่เก็บในเดือนสงิหาคมและเดือนพฤศจิกายน  

ไมแ่ตกตา่งจาก 0 
H1: คา่มธัยฐานของผลตา่งระหวา่งปริมาณอลมูิเนี่ยมในเนือ้ไม้ที่เก็บในเดือนสงิหาคมและเดือนพฤศจิกายน

แตกตา่งจาก 0 

 สมมติฐานทัง้สองนี ้จะคล้ายคลงึกบัการตัง้สมมตุิฐานส าหรับการทดสอบด้วยวิธี Paired-samples t test ซึ่ง
เปรียบเทียบคา่เฉลีย่ของผลตา่งวา่ไมต่า่งจาก 0 กบัตา่งจาก 0  
 ขัน้ตอนการวิเคราะห์มีดงันี ้

1. เลือก  Analyze > Nonparametric Tests > Legacy Dialogs > 2 Related Samples… (ภาพที่  
12.1 ก) 

2. ก าหนดตวัแปร (ภาพท่ี 12.1 ข) ดงันี ้
i. เลอืกตวัแปร Al in microgram per gram wood in August และ Al in microgram per 

gram wood in November จากรายการตวัแปรในช่องซ้าย แล้วกด  ให้มาอยู่ในช่อง 
  

ii. ที่ช่อง  เลอืก  

3. กด  
 

 

(ก) 

ภาพที่ 12.1 ค าสัง่ส าหรับการทดสอบด้วย Wilcoxon Signed-Rank test (ก)  
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(ข) 

 

(ค) 

 

(ง) 

ภาพที่ 12.1 (ต่อ) ก าหนดตวัแปรและคา่สถิติ (ข) ผลการวิเคราะห์ (ค-ง)  

 
 

 ผลการวิเคราะห์ในภาพที่ 12.1 ค แสดงจ านวนผลต่างที่มี rank เป็นลบและเป็นบวกจ านวน 10 ค่าและ 3 ค่า
ตามล าดับ (ช่อง N) โดยผลรวมรวมของ rank ที่เป็นลบและเป็นบวกมีค่าเป็น 75 และ 16 ตามล าดับ (ช่อง Sum of 



 4 

Ranks) ทัง้นี ้มีค าอธิบายใต้ตารางคือ rank ที่เป็นลบหมายถึงปริมาณอลมูิเนี่ยมในเดือนสิงหาคมมีค่าน้อยกว่าในเดือน
พฤศจิกายน สว่น rank ที่เป็นบวก เป็นค่าเฉลี่ยของ Rank หมายถึงปริมาณอลมูิเนี่ยมในเดือนสิงหาคมมีค่ามากกว่าใน
เดือนพฤศจิกายน และไมม่ีคา่ตวัอยา่งใดที่มีคา่อลมูิเนี่ยมเทา่กนัทัง้สองเดือน  

 ส าหรับค่าสถิติที่ใช้ทดสอบสมมตุิฐานนัน้ ปรากฎในตารางในภาพที่ 12.1 ง โดยเป็นค่า Z (ดเูชิงอรรถ 2) กบัคา่ 
Asymp. Sig. (2-tailed) ซึ่งจากตาราง มีน้อยกว่า 0.05 จึงปฏิเสธ Ho แล้วยอมรับ H1 นัน้คือ ค่ามธัยฐานของผลต่าง
ระหวา่งปริมาณอลมูิเนี่ยมในเนือ้ไม้ที่เก็บในเดือนสงิหาคมและเดือนพฤศจิกายนแตกตา่งจาก 0 อยา่งมีนยัส าคญัทางสถิติ
ที่ความเช่ือมัน่ 95 เปอร์เซ็นต์ 
 หากต้องการทราบคา่มธัยฐานของผลตา่งสามารถท าได้โดยสร้างตวัแปรใหม ่(สมมตุิให้ช่ือตวัแปรใหมน่ีเ้ป็น diff) 
ด้วยค าสัง่ Compute Variable ในเมนู Transform โดยก าหนดให้เป็นผลต่างระหว่างตวัแปร Al in microgram per 

gram wood in August กับตัว แปร  Al in microgram per gram wood in November แ ล้ วจึ ง ใ ช้ค าสั่ง  Case 

Summaries ในเมนู Analyze > Reports เพื่อหาค่ามัธยฐานของตวัแปร diff นี ้ซึ่งมีค่าเป็น -3.1 อย่างไรก็ตาม หาก
ต้องการทราบว่าปริมาณอลมูิเนี่ยมมี “ทิศทาง” การเปลี่ยนแปลงอย่างไรระหว่างเดือนสิงหาคมกบัเดือนพฤศจิกายนแล้ว 
สามารถพิจารณาจากจ านวนผลตา่งที่คา่ rank มีเคร่ืองหมายเป็นลบ (-) และผลตา่งที่คา่ rank มีเคร่ืองหมายเป็นบวก (+) 
ดงัตารางในภาพท่ี 12.1 ค ซึง่มีจ านวน 10 คา่และ 3 คา่ ตามล าดบั นัน้คือ โดยสว่นใหญ่แล้ว ปริมาณอลมูิเนี่ยมในเนือ้ไม้ที่
เก็บในเดือนสงิหาคมมีคา่น้อยกวา่ปริมาณอลมูิเนี่ยมในเนือ้ไม้ที่เก็บในเดือนพฤศจิกายน นัน้เอง 
 
2. Kruskal-Wallis Test 

 ในการทดลองที่มีตวัแปรแบบ nominal variable จ านวน 1 ตวัแปรและตวัแปรแบบ rank variable อีกหนึง่ตวั
แปร (แตอ่าจเป็น scale variable ได้) โดยตวัแรกที่เป็น nominal variable นี ้อาจมีคา่ได้ตัง้ 2 คา่ขึน้ไป เช่น แบคทีเรีย 2 
สายพนัธุ์ หรือความเข้มข้นของเกลอืในสารละลายส าหรับปลกูพืชทนเคม็ 5 ระดบั ตวัแปรที่เป็น rank variable พอยกเป็น
ตวัอย่างในทางชีววิทยาได้ เช่น ระดบัของความรุนแรงของโรคเป็น 1 ถึง 5 หรือระดบัทนความเข้มเป็น 1 ถึง 3 หรือระยะ
การเจริญเป็น 1 ถึง 7 ฯลฯ หรือตวัแปรที่เป็น scale variable นัน้ มีตวัอย่างหลายตวัอย่าง เช่น ขนาดของ clear zone 
หรือความสงูของต้นพืช น า้หนกัแห้งและน า้หนกัสด ฯลฯ  
 ตัวอย่างข้อมูลคือขนาดตับในผู้ ป่วยที่ท า hemodialysis กับไม่ท า hemodialysis เมื่อเทียบกับคนปกติ ดัง
ตารางด้านลา่ง ผู้วิจยัต้องการทราบวา่ขนาดของตบัมีความแตกตา่งกนัหรือไม่ 

Control 206.9 150.0 197.3 173.2 147.2 143.8 192.6    
Non-dialyzed patient 194.6 145.6 174.9 187.5 223.4 143.0 170.0    

Dialyzed patient 288.0 269.2 288.3 357.5 229.2 249.0 346.1 216.6 202.6 213.5 

 การเตรียมข้อมูลจะใช้ตัวแปร 2 ตัวแปร คือ ตัวแปรแรกช่ือ case มีค าอธิบายเป็น Case มี value เป็น 1: 

Control; 2: Non-dialyzed patient; 3: Dialyzed patient และมี measure เป็น nominal ส่วนตวัแปรตวัที่สองช่ือ 
size มีค าอธิบายเป็น Size of liver และมี measure เป็น scale 

 
 
 

                                                 

2ค่า Z เป็นค่าที่หาจากฟังก์ชัน่ 𝑧 =
|𝑇𝑚𝑖𝑛|−
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 ) และก าหนดเคร่ืองหมาย (+ หรือ -) ตามเคร่ืองหมายของ Tmin โดย N 

คือจ านวนผลต่างทัง้หมดที่มีค่าไม่เป็น 0 และ tr คือจ านวนผลต่างที่เป็น tied rank กลุ่มที่ sth และต้องรวมค่าทกุกลุ่ม r ของ tied rank 



 5 

 สมมตุิฐานเป็นดงันี ้
  Ho: คา่เฉลีย่ของ Rank ในกลุม่ตวัอยา่งทัง้สามกลุม่ไมแ่ตกตา่งกนั 

  H1: คา่เฉลีย่ของ Rank ในกลุม่ตวัอยา่งทัง้สามกลุม่แตกตา่งกนั 

 ขัน้ตอนการวิเคราะห์มดีงันี ้
1. เลือก Analyze > Nonparametric Tests > Independent Samples… (ภาพที่ 12.2 ก)  หากใน

ไฟล์ข้อมูลมีตวัแปรที่มิได้ก าหนด measurement level จะมีไดอะล็อคเตือนปรากฎขึน้มา (ภาพที่ 
12.2 ข) ให้เลอืก  เพื่อให้ SPSS 22 ก าหนด measurement level ให้ตวัแปรนัน้ หรือกด 

 เพื่อไปก าหนดเองในวินโดว์ Variable View 

2. กดแถบ  ในช่อง  เลอืก  (ภาพท่ี 12.3 ค) 
3. กดแถบ  ก าหนดคา่ดงันี ้(ภาพท่ี 12.2 ง) 

i. เลอืก  

ii. เลอืกตวัแปร Size of liver จากรายการตวัแปรในช่อง  แล้วกด  ของ 
  

iii. เลอืกตวัแปร Case จากรายการตวัแปรในช่อง  แล้วกด  ของ  

4. กดแถบ  ก าหนดคา่ดงันี ้(ภาพท่ี 12.2 จ) 
i. ที่ช่อง  เลอืก  

ii. เลอืก  

iii. ที่ช่อง  เลอืก 
 และก าหนด  เป็น 

 

5. กด  จะได้ผลดงัภาพที่ 12.2 ฉ ซึ่งมีเพียง 1 ตาราง ให้พิจารณาที่คอลมัน์ Sig. จะเห็นว่ามีค่า 
0.001 ซึง่มีคา่น้อยกวา่ 0.05 จึงปฏิเสธ Ho แล้วยอมรับ H1 นัน้คือ คา่เฉลีย่ของ Rank ในกลุม่ตวัอยา่ง
ทัง้สามกลุ่มแตกต่างกนัอย่างมีนยัส าคญัทางสถิติที่ความเช่ือมัน่ 95 เปอร์เซ็นต์ สงัเกตว่าใน ตาราง 
Hypothesis Test Summary นี ้ไม่มีค่าสถิติที่เก่ียวข้องกบั Kruskal-Wallis test ได้แก่ ค่า H (หรือ
คา่ Chi-Square) และคา่ df น าเสนอ มีเพียงคา่ Asymp. Sig. เทา่นัน้ 

6. เลือ่นเม้าส์ไปวางที่ตาราง Hypothesis Test Summary แล้วกดแปน้ซ้ายของเม้าส์ 2 ครัง้ จะมีวินโดว์ 

Model Viewer ขึน้มา (ภาพที่ 12.2 ช) ประกอบด้วย main view และ auxiliary view  
i. Main view เป็นช่องด้านซ้ายที่ประกอบด้วยผลการวิเคราะห์ในภาพรวม ที่ด้านลา่งของช่อง

นี ้จะมีเมนูให้เลือกแสดงผลการวิเคราะห์อื่น ๆ หากมีการวิเคราะห์หลาย ๆ การวิเคราะห์ 
ส าหรับตวัอยา่งนี ้มีผลการวิเคราะห์เพียง 1 ผลเทา่นัน้ จึงไมม่ีตวัเลอืกอื่นใด 

ii. Auxiliary view เป็นช่องด้านขวาที่ประกอบด้วยรายละเอียดต่าง ๆ ได้แก่ กราฟ ตาราง
ค่าสถิติพรรณา ตารางคา่สถิติส าหรับทดสอบสมมตุิฐาน รวมถึง Post-hoc test (ถ้ามี) ฯลฯ 
ทัง้นี ้รายละเอียดผลการวิเคราะห์จะเปลี่ยนไปตามวิธีการทดสอบสมมุติฐานและผลการ
ทดสอบสมมตุิฐานวา่ปฏิเสธหรือไม่ปฏิเสธ Ho ซึ่งสามารถเลือกได้จากตวัเลือกในเมนทูี่ด้วย
ลา่งของช่องนี ้และในการทดสอบด้วย Kruskal-Wallis test นี ้มีรายละเอียด 4 รายการ 
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7. ที่ auxiliary view จากเมนูของ   เลือก  จะได้กราฟเปรียบเทียบ 

mean rank ของแต่ละกลุม่และตาราง Post-hoc test (ภาพที่ 12.2 ซ) ซึ่งจากตาราง เมื่อพิจารณา

ค่า Adj. Sig.3 ของคู่ Control กับ Non-dialysis patient พบว่ามีค่ามากกว่า 0.05 แสดงว่ากลุ่ม 

Control กบักลุม่ Non-dialysis patient มีขนาดตบัไมแ่ตกตา่งกนัอย่างมีนยัส าคญัทางสถิติ แต่เมื่อ

พิจารณาค่า Adj. Sig. ของคู่  Control กับ  Dialysis patient และคู่  Non-dialysis patient กับ 

Dialysis patient พบว่ามีค่าน้อยกว่า 0.05 แสดงว่า Control กับ Non-dialysis patient ทัง้สอง

กลุม่นีม้ีขนาดตบัแตกตา่งจากขนาดตบัของกลุม่ Dialysis patient อยา่งมีนยัส าคญัทางสถิติ 

8. เมื่อต้องปิดวินโดว์ model viewer ให้เลอืก File > Close จากเมนใูนวินโดว์นี ้

 

(ก) 

 

(ข) 

ภาพที่ 12.2 ค าสัง่ส าหรับการทดสอบด้วย Kruskal-Wallis test (ก) ข้อความเตือนเก่ียวกบั measurement level ของ
ตวัแปรในไฟล์ข้อมลูเมื่อมตีวัแปรยงัไมไ่ด้รับการก าหนดระดบั 

 

                                                 
3

 SPSS 22 ประมาณคา่ Adj. Sig. ตาม Dunn-Bonferroni test (Dunn, O. J. 1964. Multiple comparisons using 

rank sums. Technometrics, 6, 241-252.) 
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(ค) 

 

(ง) 

ภาพที่ 12.2 (ต่อ) ก าหนดการวเิคราะห์เองในแถบ Objective (ค) ก าหนดตวัแปรส าหรับการวิเคราะห์ (ง)  
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(จ) 

 

(ฉ) 

ภาพที่ 12.2 (ต่อ) ก าหนดการวเิคราะห์เป็น Kruskal-Wallis และ Post-hoc tests (จ) ผลการวเิคราะห์ (ฉ)  
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(ช) 

 

(ซ) 

ภาพที่ 12.2 (ต่อ) วินโดว์ model view แสดงรายละเอียดการวิเคราะห์ด้วย Kruskal-Wallis (ช) และ Post-hoc tests   (ซ) 

 

 ผลการวิเคราะห์แสดงในภาพที่ 12.2 ฉ เป็นการตัง้สมมุติฐานและสรุปผลการทดสอบสมมุติฐานตามวิธี  

Kruskal-Wallis test และน าเสนอเพียง Sig. เทา่นัน้ หากต้องการรายละเอียดเพิ่มเตมิ ต้องเข้าไปในวินโดว์ model view 
(ภาพที่ 12.2 ช) แล้วเลือกแสดงรายละเอียดจากเมนูที่ด้านล่างของช่อง auxiliary view ต่อไป หากต้องการคัดลอก
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รายละเอียดใน model viewer สามารถท าได้โดยกด  แล้วไปวางใน Microsoft Word โดยจะเป็นภาพ ไม่ใช่ตาราง 

หรือกด  เพื่อพิมพ์เป็นเอกสารได้ 
 ตวัอยา่งข้อมลูอีกตวัอยา่งหนึง่เป็นผลการวิจยัตวัยาใหมท่ี่จะน ามาใช้กบัเด็กที่เป็นโรคภมูิแพ้ โดยผู้วิจยัได้
คดัเลอืกเด็กทีว่ินิจฉยัวา่เป็นโรคภมูิแพ้จ านวน 10 คน แล้วแบง่เป็น 2 กลุม่ กลุม่แรกได้รับเพลซซิโบ (placebo) อีกกลุม่
หนึง่ได้รับยาสตูรใหม ่จากนัน้ให้เด็กบนัทกึจ านวนครัง้ของอาการที่หายใจติดขดัในระยะเวลา 1 สปัดาห์ ได้ข้อมลูดงันี  ้

Placebo 7 5 6 4 12 

New drug 3 6 4 2 1 

 การเตรียมข้อมลูจะใช้ตวัแปร 2 ตวัแปร คือ ตวัแปรแรกช่ือ pill มีค าอธิบายเป็น Pill มี value เป็น 1: Placebo; 

2: New drug และมี measure เป็น nominal สว่นตวัแปรตวัที่สองช่ือ breath มีค าอธิบายเป็น Number of shortness 

of breath และมี measure เป็น scale 

 สมมตุิฐานเป็นดงันี ้
  Ho: คา่เฉลีย่ของ Rank ของกลุม่เด็กที่ได้รับเพลซซิโบกบักลุม่เด็กที่ได้รับยาสตูรใหมไ่มแ่ตกตา่งกนั 

  H1: คา่เฉลีย่ของ Rank ของกลุม่เด็กที่ได้รับเพลซซิโบกบักลุม่เด็กที่ได้รับยาสตูรใหมแ่ตกตา่งกนั 

 ขัน้ตอนการวิเคราะห์มดีงันี ้
1. เลือก Analyze > Nonparametric Tests > Independent Samples… (ภาพที่ 12.2 ก)  หากใน

ไฟล์ข้อมูลมีตวัแปรที่มิได้ก าหนด measurement level จะมีไดอะล็อคเตือนปรากฎขึน้มา (ภาพที่ 
12.2 ข) ให้เลอืก  เพื่อให้ SPSS 22 ก าหนด measurement level ให้ตวัแปรนัน้ หรือกด 

 เพื่อไปก าหนดเองในวินโดว์ Variable View 

2. กดแถบ  ในช่อง  เลอืก  (ภาพท่ี12.2 ค)) 
3. กดแถบ  ก าหนดคา่ดงันี ้

i. เลอืก  

ii. เลอืกตวัแปร Number of shortness of breath in… จากรายการตวัแปรในช่อง  
แล้วกด  ของ   

iii. เลอืกตวัแปร Pill จากรายการตวัแปรในช่อง  แล้วกด  ของ  

4. กดแถบ  ก าหนดคา่ดงันี ้(ภาพท่ี 12.3 ก) 
i. ที่ช่อง  เลอืก  

ii. เลอืก  

iii. ที่ช่อง  เลอืก 
และ  และก าหนด  เป็น 

 [เพราะเหตใุดจึงเลอืกเช่นนี?้] 

5. กด  จะได้ผลดงัภาพท่ี 12.3 ข ซึง่มีตาราง 2 ตาราง ให้พิจารณาที่คอลมัน์ Sig. ในตารางทัง้สอง
มีค่าไม่เท่ากัน กล่าวคือ Sig. ในตาราง 1 ซึ่งเป็น Mann-Whitney U test เป็น Exact Sig. มีค่า
มากกวา่ 0.05 จึงไม่ปฏิเสธ Ho นัน้คือ ค่าเฉลี่ยของ Rank ของกลุม่เด็กที่ได้รับเพลซซิโบกบักลุม่เด็กที่
ได้รับยาสตูรใหม่ไม่แตกต่างกันอย่างมีนยัส าคญัทางสถิติที่ความเช่ือมัน่ 95 เปอร์เซ็นต์ แต่ Sig. ใน
ตารางที่ 2  ซึ่งเป็น Kruskal-Wallis test เป็น Asymp. Sig. มีค่าน้อยกว่า 0.05 จึงปฏิเสธ Ho แล้ว
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ยอมรับ H1 นัน้คือ ค่าเฉลี่ยของ Rank ของกลุ่มเด็กที่ได้รับเพลซซิโบกับกลุ่มเด็กที่ได้รับยาสตูรใหม่
แตกตา่งกนัอยา่งมีนยัส าคญัทางสถิติที่ความเช่ือมัน่ 95 เปอร์เซ็นต์ 

6. เมื่อเลื่อนเม้าส์ไปวางที่ตาราง Hypothesis Test Summary แล้วกดแป้นซ้ายของเม้าส์ 2 ครัง้ จะมี
วินโดว์ Model Viewer ขึน้มา (ภาพที่ 12.3 ค)  

i. Main view ประกอบด้วยผลการวิเคราะห์ 2 การวิเคราะห์ คือ Mann-Whitney U test 
และ Kruskal-Wallis test 

ii. Auxiliary view หากเลือกผลการวิเคราะห์ของ Mann-Whitney U test ใน main view 
แล้ว รายละเอียดผลการวิเคราะห์จะแสดงใน auxiliary view ดงัภาพที่ 12.3 ค แตห่ากเลอืก
การวิเคราะห์ของ Kruskal-Wallis test ใน main view แล้ว รายละเอียดผลการวิเคราะห์
จะแสดงใน auxiliary view ดังภาพ 12.3 ง ให้สงัเกต Asymp. Sig. จากการวิเคราะห์ทัง้
สองวิธีนีม้ีคา่เทา่กนั คือ 0.046 

iii. เมื่อต้องปิดวินโดว์ model viewer ให้เลอืก File > Close จากเมนใูนวินโดว์นี ้

 ผลการวิเคราะห์แสดงในภาพท่ี 12.3 ข เป็นการตัง้สมมตุิฐานและสรุปผลการทดสอบสมมตุิฐานตามวิธี  Mann-

Whitney U test และ Kruskal-Wallis test และน าเสนอเพียง Sig. เทา่นัน้ หากต้องการรายละเอียดเพิ่มเตมิ ต้องเข้าไป
ในวินโดว์ model view (ภาพที่ 12.3 ค-ง) สงัเกตการตัง้สมมตุิฐานในการทดสอบทัง้วิธีนีเ้หมือนกนั แต่ผลการทดสอบ
สมมุติฐานแตกต่างกัน ในการทดสอบสมมุติฐานนัน้ หากสามารถได้ค่า Exact Sig. ให้ใช้ Exact Sig. ในการทดสอบ
สมมตุิฐานเสมอ อีกประการหนึ่ง หากค่า Asymp. Sig. มีค่าเข้าใกล้ 0.05 และมีจ านวนค่าสงัเกตไม่มาก (น้อยกว่า 500 
ค่า) ให้ใช้การวิเคราะห์ใน Nonparametric Tests > Legacy Dialogs > 2 Independent Samples… (หรือเลือก 
Nonparametric Tests > Legacy Dialogs > K Independent Samples…) แล้วระบใุห้ค านวนค่า Exact Sig. ในการ
วิเคราะห์แทน เพื่อให้ได้คา่ Exact Sig. ส าหรับใช้ทดสอบสมมตุิฐานตอ่ไป 
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(ก) 

 

(ข) 

ภาพที่ 12.3 เลอืกการวิเคราะห์เป็น Mann-Whitney U test และ Kruskal-Wallis test ที่ข้อมลูแบง่เป็น 2 กลุม่ (ก) 
ผลการวิเคราะห์ (ข) 
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(ค) 

 

(ง) 

ภาพที่ 12.3 (ต่อ) รายละเอียดผลการวิเคราะห์ด้วย Mann-Whitney U test ที่ข้อมลูแบง่เป็น 2 กลุม่ (ค) 
รายละเอียดผลการวิเคราะห์ด้วย Kruskal-Wallis test ที่ข้อมลูแบง่เป็น 2 กลุม่ (ง) 

 

 
 
3. Spearman rank correlation coefficient 

 การทดลองที่ต้องการหาความสมัพนัธ์ระหว่างตวัแปรแบบ ordinal variable (หรือ rank variable) จ านวน 2 
ตวัแปรหรือระหว่างตวัแปร 2 ตวัแปรที่ตวัแปรหนึ่งเป็นตวัแปรแบบ ordinal variable กบัอีกตวัแปรหนึ่งเป็นตวัแปรแบบ 
scale variable จะใช้ Spearman correlation coefficient หรือ rho โดยจะพิจารณาว่า rank ของตัวแปรหนึ่งจะ
แปรเปลี่ยนร่วมกบั rank ของอีกตวัแปรหนึ่งหรือไม่ กลา่วคือ เมื่อ rank ของตวัแปรหนึ่งเพิ่มขึน้แล้ว rank ของอีกตวัแปร
หนึง่หรือเพิ่มขึน้ (หรือลดลง) หรือไม่ 



 14 

 ตวัอย่างข้อมลูจาก Melfi and Poyser (2007)4 ซึ่งศึกษาพฤติกรรมของลิงโคโลบสั Colobus guereza เพศผู้  

6 ตวัในสวนสตัว์แหง่หนึง่ โดยสงัเกตจากการผลกักนัของลงิให้พ้นจากพืน้ที่ท่ีตวัมนัอยู ่ผู้วิจยัสามารถทราบวา่ลงิตวัใดเป็น
ตวัที่อิทธิพลมากกว่าตวัอื่นและให้ล าดบัขัน้ (หรือ rank) จากมากไปหาน้อย (1 สงูสดุ ถึง 6 ต ่าสดุ และไม่ทราบว่าการมี
อิทธิพลเหนือตวัอื่นระหว่าง 1-2 จะเท่ากับ 2-3 หรือไม่ ฯลฯ) จากนัน้นบัไข่หนอนตวักลม Trichuris ที่ปนกับอุจาระลิง 
ได้ผลดงัตารางด้านลา่งนี ้ผู้วิจยัต้องการทราบวา่ล าดบัการมีอิทธิพลเหนือตวัอื่นกบัจ านวนไขห่นอนตวักลม มีความสมัพนัธ์
กนัหรือไม ่

Monkry name Dominance rank Egg per gram 

Erroll 1 5777 

Milo 2 4225 

Fraiser 3 2674 

Fergus 4 1249 

Kabul 5 749 

Hope 6 870 

 การเตรียมข้อมูลจะใช้ตวัแปร 2 ตวัแปร คือ ตวัแปรแรกช่ือ dominance มีค าอธิบายเป็น Dominance rank 
และมี measure เป็น ordinal สว่นตวัแปรตวัที่สองช่ือ egg มีค าอธิบายเป็น Number of nematode eggs per gram 

feces และมี measure เป็น scale 

 สมมตุิฐานเป็นดงันี ้
Ho: ล าดบัการมีอิทธิพลเหนือตวัอื่นกบัจ านวนไขห่นอนตวักลมไมม่ีความสมัพนัธ์กนั หรือ rho ไมต่า่งจาก 0 
H1: ล าดบัการมีอิทธิพลเหนือตวัอื่นกบัจ านวนไขห่นอนตวักลมมีความสมัพนัธ์กนั หรือ rho ตา่งจาก 0 

 ขัน้ตอนการวิเคราะห์มีดงันี ้
1. เลอืก Analyze > Correlate > Bivariate…  

2. เลือกตัวแปร Dominance rank และ Number of nematode… ในช่องรายการตัวแปรด้านซ้าย 
แล้วกด  ให้มาอยูใ่นช่อง  (ภาพท่ี 12.4 ก) 

3. ในช่อง  เลอืก  (ภาพท่ี 12.4 ก) 
4. ในช่อง  เลอืก  (ภาพท่ี 12.4 ก) 
5. เลอืก  (ภาพท่ี 12.4 ก) 
6. กด   

 ผลการวิเคราะห์แสดงในภาพที่12.4 ข โดยตารางจะมีรายละเอียดเช่นเดียวกนักบัผลการวิเคราะห์ความสมัพนัธ์
เพื่อหาค่า Pearson’s correlation coefficient แต่จะแสดงค่า Spearman’s correlation coefficient แทน และค่า 
Sig. (2-tailed) ซึง่หากมีคา่น้อยกวา่ 0.05 หรือ 0.01 จะมี * หรือ ** (ตามล าดบั) หลงัคา่ coefficient 

 เนื่องจาก Sig. (2-tailed) มีค่า 0.005 ซึ่งน้อยกว่า 0.05 จึงปฏิเสธ  Ho แล้วยอมรับ H1 นัน้คือ ล าดับการมี
อิทธิพลเหนือตวัอื่นกบัจ านวนไข่หนอนตวักลมมีความสมัพนัธ์กนั หรือ rho ต่างจาก 0 อย่างมีนยัส าคญัทางสถิติที่ความ
เช่ือมัน่ 95 เปอร์เซ็นต์ โดย Spearman’s rho มีคา่ 0.943 

 

                                                 
4

 Melfi, V., and F. Poyser. 2007. Trichuris burdens in zoo-housed Colobus guereza. International Journal of 

Primatology 28: 1449-1456. 
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(ก) 

 

(ข) 

ภาพที่ 12.4 ก าหนดตวัแปรและคา่สถิติส าหรับการวิเคราะห์สหสมัพนัธ์ Spearman (ก) ผลการวิเคราะห์ (ข)  
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แบบฝึกหดัปฏิบตัิการที่ 12 การวิเคราะห์ทางสถติิแบบนอนพาราเมตริกซ์ 

 

1. ในการศกึษาเก่ียวกบัการใช้ Captopril ในผู้ ป่วยที่เป็น Diuretic-treated hypertensive patient ผู้วิจยัเช่ือวา่สารนี ้
มีผลท าให้ความดนัเลือดในผู้ ป่วยลดลง เพื่อทดสอบสมมตุิฐานนี ้ผู้วิจยัได้ให้สาร  Captopril ปริมาณ 6.25 กรัม แก่ผู้ ป่วย
เหล่านี  ้โดยวัด Systolic blood pressure ของผู้ ป่วยทุกคน ก่อนได้รับสาร  Captopril (X) และวัด Systolic blood 

pressure ของผู้ ป่วยคนเดิมอีกครัง้หลงัจากได้รับสาร Captopril แล้ว 70 นาที (Y) ได้ผลดงันี ้
Patient 1 2 3 4 5 6 7 8 9 10 

X 175 179 165 170 160 180 177 178 173 176 

Y 140 143 135 133 162 150 182 139 140 141 

หากข้อมลูไมไ่ด้มกีารกระจายแบบปกติแล้ว จงตัง้สมมตุฐิาน ทดสอบสมมตุิฐานท่ีตัง้ และสรุปผลการทดสอบ พร้อมทัง้
ระบวุา่ Captopril ลดความดนัหรือไม ่
 

2. ในการศึกษาผลของการสบูบหุร่ีต่อการนอนหลบัโดยผู้ วิจยัได้ให้ความสนใจกับตัวแปรหนึ่ง คือ เวลาที่อาสาสมคัรจะ
หลบั (นาที) ผู้วิจยัจึงได้สุม่ตวัอยา่งกลุม่คนสบูบหุร่ี (S) 12 คน และกลุม่คนไมส่บูบหุร่ี (NS) 15 คน ได้ผลดงันี ้

S 69.3 56.0 22.1 47.6 53.2 48.1 23.2 13.8 52.7 34.4 60.2 43.8    

NS 28.6 25.1 26.4 34.9 29.8 38.4 38.5 30.2 30.6 31.8 41.6 21.1 36.0 37.9 13.9 

หากข้อมลูไมไ่ด้มกีารกระจายแบบปกติแล้ว จงตัง้สมมตุฐิาน ทดสอบสมมตุิฐานท่ีตัง้ และสรุปผลการทดสอบ ระบดุ้วยวา่
กลุม่ใดหลบัได้เร็วกวา่ 

 

3. ภาวะขาดวิตามิน A เป็นปัญหาที่พบได้ทัว่ไป และเป็นที่ทราบว่าการบริโภคผกัจะช่วยให้ความเข้มข้นวิตามิน A ในน า้
เลือดเพิ่มขึน้ ผู้วิจยัจึงหาวิธีที่ให้เด็กได้รับวิตามิน A อย่างเพียงพอ โดยอยากทราบว่าการเติมไขมนัลงไปในอาหารที่มีผกั
อยูแ่ล้ว จะช่วยให้มีความเข้มข้นวิตามิน A ในน า้เลอืดเพิ่มขึน้หรือไม ่ผู้วิจยัสุม่ตวัอยา่งเด็ก 28 คน ได้ผลดงันี  ้

Fat added Vitamin A concentration (mg/100 mL blood plasma) 

I (0g fat added) 18.1 16.5 21.0 18.7 7.4 12.4 16.1 17.9   

II (5g fat added) 29.1 15.8 20.4 23.5 18.5 21.3 23.1 23.8 20.1 11.9 

III (10 g fat added) 26.6 16.1 18.8 25.0 21.8 15.4 19.9 15.5 21.1 25.5 

หากข้อมลูไมไ่ด้มกีารกระจายแบบปกติแล้ว จงตัง้สมมตุฐิาน ทดสอบสมมตุิฐานท่ีตัง้ และสรุปผลการทดสอบ 

 

4. ในการศึกษาความสมัพนัธ์ระหว่างความสามารถของตาในการติดตามวตัถุที่เคลื่อนที่อย่างช้า ๆ ได้อย่างราบร่ืนกบั
ระดับปริมาณอลักอฮอล์ในเลือด ผู้ วิจัยได้สุ่มกลุ่มตวัอย่างอาสาสมคัร 12  คน โดยได้วัดความเร็วสูงสุดของตาในการ
ติดตามวตัถทุี่เคลื่อนที่อยา่งช้า ๆ ได้อย่างราบร่ืน จากนัน้ให้อาสาสมคัรดื่มจินหรือวิสกีห้รือโทนิคในปริมาณที่มากพอท่ีจะ
ท าให้ไม่สามารถขบัรถได้ แล้วจึงวดัปริมาณแอลกอฮอล์ในเลือด (มิลลิกรัมตอ่เดซิลิตร, X) พร้อมทัง้วดัความเร็วสงูสดุของ
ตาในการติดตามวตัถทุี่เคลื่อนที่อย่างช้า ๆ ได้อย่างราบร่ืนของอาสาสมคัรอีกครัง้หนึ่ง แล้วหาเปอร์เซ็นต์ที่ลดลงของการ
ติดตามการเคลือ่นท่ีอยา่งช้า ๆ ได้อยา่งราบร่ืน (Y) ได้ผลดงันี ้

X 20 45 68 68 70 75 85 86 108 110 120 150 

Y 2 11 30 50 4 6 19 30 38 10 51 60 

หากข้อมลูไมไ่ด้มกีารกระจายแบบปกติแล้ว จงตัง้สมมตุฐิาน ทดสอบสมมตุิฐานท่ีตัง้ และสรุปผลการทดสอบ 
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การบ้านปฏิบตักิารที่ 12 การวเิคราะห์ทางสถติิแบบนอนพาราเมตริกซ์ 

 

1. ผู้วิจยัต้องการทราบวา่ยาชา 2 ชนิดจะชว่ยบรรเทาความเจ็บปวดให้ผู้ ป่วยโรคข้ออกัเสบ (arthritis) ได้นานแตกตา่งกนั
หรือไม ่จึงทดลองใช้ยาทัง้สองชนดิในผู้ ป่วย 12 คน แล้วบนัทกึเวลาที่บรรเทาความเจ็บปวด ได้ผลดงันี  ้

Case 1 2 3 4 5 6 7 8 9 10 11 12 

Drug A  2.0 3.6 2.6 2.6 7.3 3.4 14.9 6.6 2.3 2.0 6.8 8.5 

Drug B  3.5 5.7 2.9 2.4 9.9 3.3 16.7 6.0 3.8 4.0 9.1 20.9 

หากข้อมลูไมไ่ด้มกีารกระจายแบบปกติแล้ว จงตัง้สมมตุฐิาน ทดสอบสมมตุิฐานท่ีตัง้ และสรุปผลการทดสอบ พร้อมทัง้
ระบวุา่ยาใดบรรเทาความเจ็บปวดได้นานกวา่ 

 

2. ในการทดสอบยาระดบัคลนิิกเพื่อประเมินประสทิธิผลของการบ าบดัผู้ ป่วยทีม่ีเช่ือ HIV ด้วย anti-retroviral therapy 
แบบเดิมกบัแบบใหมโ่ดยวดั viral load ในผู้ ป่วยหลงัจากบ าบดัไปแล้ว 3 เดือน ได้ผลดงันี ้
 Viral load (the number of HIV copies per milliliter of blood) 

Standard 
Therapy 

7500 8000 2000 550 1250 1000 2250 6800 3400 6300 9100 970 1040 670 400 

New 
Therapy 

400 250 800 1400 8000 7400 1020 6000 920 1420 2700 4200 5200 4100 undetectable 

หากข้อมลูไมไ่ด้มกีารกระจายแบบปกติแล้ว จงตัง้สมมตุฐิาน ทดสอบสมมตุิฐานท่ีตัง้ และสรุปผลการทดสอบ พร้อมทัง้
ระบวุา่วิธีแบบใดมีประสทิธิผลดกีวา่ 

 

3. ในทางการแพทย์ ระดบัอลับมูนิในน า้เลอืดเป็นตวับง่ชีว้า่ผู้ ป่วยได้รับโปรตีนจากอาหารท่ีรับประทานเพียงพอหรือไม ่
ผู้วิจยัจงึได้คดัลอืกอาสาสมคัรแล้วแบง่ออกเป็น 3 กลุม่ให้รับประทานอาหารทีม่ีโปรตีนในอาหารสดัสว่นตา่งกนั แล้ววดั
ปริมาณอลับมูินในน า้เลอืด ได้ผลดงันี ้

Amount of protein in diet Albumin in blood (g/dL) 

5%  3.1 2.6 2.9   

10%  3.8 4.1 2.9 3.4 4.2 

15%  4.0 5.5 5.0 4.8  
หากข้อมลูไมไ่ด้มกีารกระจายแบบปกติแล้ว จงตัง้สมมตุฐิาน ทดสอบสมมตุิฐานท่ีตัง้ และสรุปผลการทดสอบ พร้อมทัง้
ระบวุา่กลุม่ใดนา่จะมีปริมาณอลับมูินในน า้เลอืดสงูกวา่ 

 

4. การประเมินสขุภาพของทารกแรกคลอดด้วย Apgar score ซึง่พิจารณาเง่ือนไข 5 เง่ือนไขแล้วให้คะแนน 0 หรือ 1 หรือ 
2 โดยแต่ละเง่ือนไขจะมีข้อก าหนดที่สงัเกตได้จากทารกแรกคลอดส าหรับคะแนนแต่ละคา่ แล้วจึงรวมคะแนนทัง้หมดเข้า
ด้วยกนั หาก Apgar score มีค่าตัง้แต ่0 ถึง 10 และเป็น ordinal variable โดยคะแนน 0-3 เป็นค่าต ่ามาก คะแนน 4-6 
ต ่า ส่วนคะแนนตัง้แต่ 7 เป็นค่าปกติ เนื่องจากผู้ วิจยัสนใจว่ามีความสมัพนัธ์ระหว่าง Apgar score ที่เวลา 1 นาทีกับ 5 
นาทีหลงัคลอดหรือไม ่จึงประเมิน Apgar score ในทารกแรกเกิด 24 คนท่ีเวลา 1 นาทีและ 5 นาทีหลงัคลอด ผลเป็นดงันี ้

Infant 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 

1 min 10 3 8 9 8 9 8 8 8 8 7 8 6 8 9 9 9 9 8 9 3 9 7 10 

5 min 10 6 9 10 9 10 9 9 9 9 9 9 9 10 10 10 10 9 10 9 3 9 10 10 

จงตัง้สมมตุิฐาน ทดสอบสมมตุิฐานท่ีตัง้ และสรุปผลการทดสอบ 


